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Introduction 

This document discusses the recommended practices for working with player compatible media files in a 

Show Control System and Visiconn System. It discusses helpful guidelines to follow when creating media 

files; what types of files a system can support; tips and guidelines for working with different types of fonts; 

and steps for how to import media files from a portable storage device. 

 

 

Note: , , and  are used throughout this document to identify information 

which only applies to certain digital media players. Information tagged with a 7 applies to 

DMP-7000 systems, information tagged with an 8 applies to DMP-8000 systems, and 

information tagged with a 15 applies to DMP-1500/M3 systems.  

Media Item Creation Guidelines 

It is recommended to follow the below guidelines when creating display content to ensure the best results 

when the content is played. 

General Recommendations 

 Filenames of content files which are to be played on DMP-7000 or DMP-8000 signs may not exceed 

32 characters (requirement to use ERTD commands) 

 Content resolution should be 72 DPI and should equal the pixel dimensions of the display the content 

is designed for. This will ensure that the content does not appear distorted on the display.   

 Create content in RGB (red, green & blue) color space. 

 Content created for 360-degree fascia displays should be repeated a minimum of four times across 

the display to ensure visibility from all seats. 

 Optimal length for content is 10 – 15 seconds.  This allows the message to be conveyed effectively to 

the greatest number of spectators before their attention is focused elsewhere. 

Design Tips 

 The most important principle for creating effective content is visual prioritization of the message. 

Define the items you want to communicate and prioritize each piece. 

 Make sure motion does not get in the way of comprehension or readability.  Hold text long enough 

for viewers to read and comprehend the message. 

 Presentations containing multiple animated or video media RTD fields that play simultaneously may 

cause degraded system performance. If you notice that your system lags or is otherwise slow to 

respond when playing such presentations, please consider reducing the number of RTD elements in 

your content. 
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Text Tips 

 Try various fonts to find the one that works best and is easiest to read on your sign. 

 Outlines and drop shadows applied to text can greatly increase legibility. 

 Using too many fonts may make a message appear cluttered and busy. 

 A script font may make a message more difficult to read. 

 Use the following recommendations to determine the appropriate size for text: 

 

Text Height Recommendations 

Distance from 

display 

(in feet) 

LED Resolution 

(in mm) 

Minimum text 

height 

(in inches) 

5-50 3-8 1-2 

50-100 6-12 2-4 

100-200 12-25 4-8 

200-300 25-34 8-10 

300-350 34-66 10-15 

350-500 34-66 15-20 

500-600 66-76 20-24 

600+ 76-90 24-40 

Color Tips 

 Vivid, high-quality logos, images and text should appear in front of a contrasting background. 

 Dark backgrounds allow logos to capture the viewer’s attention and can have a simple clean look. 

 Bright and saturated colors work better than pastel or low-contrast color. 

Animation Tips 

 Content which is intended to be played continuously should loop or transition smoothly 1 time from 

end to beginning to provide a seamless loop for consecutive playback. 

Audio Tips 

 Audio should always be uncompressed (PCM). 

 Audio should be interleaved with the video frames of the video file. 

 The file should preload 500 ms – 2 seconds of audio before the video starts and the audio should be 

interleaved between each frame of video. 

 Audio can be mono or stereo, but surround sound modes are not currently supported. 
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Image and Video File Support 

The Show Control System is designed to support a wide variety of the most commonly used image, 

animation, and video file types. There are three levels of Show Control file support: 

1. Native Player Support 

File types which are categorized as Native Player Support files can be loaded directly onto a 

supporting digital media player for playback. No manipulation or conversion of these files is 

necessary. 

2. Content Studio Support 

File types which are categorized as Content Studio Support files can be imported into Content 

Studio for inclusion into media presentations and will be converted to a native player support file 

format when saved. For a quick and convenient way to convert a group of files, refer to Converting a 

group of media files at once. 

File types with an “(Open)” notation (M2M and VMPF) are able to be opened and edited within 

Content Studio. 

3. Not Supported 

File types which are not categorized as Native Player Support or Content Studio Support are not able 

to be played by a digital media player or imported into Content Studio without being converted into 

a supported file format. For Daktronics’ recommendations for converting Not Supported files into a 

supported format, refer to the Video File Conversion section. 
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File Format Recommendations 

The below chart details Show Control’s support for common media file types. File types which are listed in 

boldface are recommended. 

 

 Content Studio 

Support 

DMP-7000 Native 

Support 

DMP-8000 v5  

Native Support 

DMP-1500/M3  

Native Support 

AVI • See Video File Support See Video File Support See Video File Support 

BMP • • 
• 

* See Table Key • 

CMP  •   

CUR  •   

DIB  •   

EPS  •   

GIF • • • • 

ICO  •   

JPG • • • • 

M2M • (Open)   • 

MAC  •   

MOV • ** See Table Key • ** See Table Key 

MP3   •  

MP4 •  •  

MPG •  •  

MP4V *** See Table Key    

PCD  •   

PCM  •   

PCT  •   

PCX  •   

PDF  •   

PNG • • • • 

PSD **** See Table Key    

RAS  •   

SQ7 ***** See Table Key •   

SWF   •  

TGA  • •  

TIF • • • • 

VMPF • (Open)  •  
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 Content Studio 

Support 

DMP-7000 Native 

Support 

DMP-8000 v5  

Native Support 

DMP-1500/M3  

Native Support 

VMPL 1.x   •  

WAV  • •  

WMV Refer to Video File Conversion section for conversion directions. 

 

 

Table Key: 

(Open) refers to the user’s ability to open these types of files in Content Studio, as opposed to simply 

importing them into a presentation. 

 

* About BMP files:  For Visiconn Systems with DMP-8000 players, only 24 bit BMP files are supported (16 

and 32-bit  BMP files are NOT supported). 

** About MOV files:  MOV files are supported by both Content Studio and natively supported by DMP-

8000.  If using an MOV file with DMP-7000 or DMP-1500, you must either use Content Studio to import 

the MOV file into a presentation, or convert the file into a format supported by the applicable digital 

media player (Refer to Video File Conversion section for conversion directions). Venus 7000 Sequence 

Editor can also convert MOV files. 

 

*** About MP4V files:  MP4V files are supported by Content Studio.  If using an MP4V file with DMP-

8000, DMP-7000 or DMP-1500, you must either use Content Studio to import a MP4V file into a 

presentation, or convert the file into a format supported by the applicable digital media player (Refer to 

Video File Conversion section for conversion directions). Venus 7000 Sequence Editor can also convert 

MP4V files. 

 

**** About PSD files:  PSD files are supported by Content Studio.  If using an PSD file with DMP-8000, 

DMP-7000 or DMP-1500, you must either use Content Studio to import a PSD file into a presentation, or 

convert the file into a format supported by the applicable digital media player (Refer to Video File 

Conversion section for conversion directions). Venus 7000 Sequence Editor can also convert PSD files. 

 

***** About SQ7 files:  When Content Studio saves a new DMP-7000 presentation it will create both an 

SQ7 and VMPF file, but it is only able to open the VMPF file for editing.  Subsequent Content Studio saves 

of the presentation will also update the SQ7 file.  Note that SQ7 files which were created using V7 

Sequence Designer cannot be opened and edited in Content Studio. 

File Extensions: 

AVI: Audio Video Interleave BMP: Bitmap image 

CMP: Lead Compressed CUR: Cursor image 

DIB: Device Independent Bitmap image EPS: Encapsulated PostScript image 

GIF: Graphics Interchange Format image ICO: Icon image 

JPG: Joint Photographic Experts Group image M2M: Venus 1500 Message file 

MAC: MacPaint image MOV: Apple QuickTime Movie file 

MP3: MPEG-1 or 2 Audio Layer III audio file MP4: MPEG-4 video 

MPG: MPEG (Moving Picture Experts Group) video PCD: Kodak Photo CD image 
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PCM: Pulse Code Modulation audio file PCT: Macintosh PICT image 

PCX: Paintbrush Bitmap image PDF: Portable Document Format file 

PNG: Portable Network Graphic image PSD: Adobe Photoshop image 

RAS: Sun Raster Graphic image SQ7: Venus 7000 Sequence file 

SWF: Small Web Format (Flash Movie) file TGA: Targa Graphic image 

TIF: Tagged Image File VMPF: Venus Media Presentation File 

VMPL: Venus Media Presentation Language file WAV: Waveform audio file 

WMV: Windows Media Video file  
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SCS with DMP-7000 Video File Support 

 

Tech Note: 
Filenames for DMP-7000 content files cannot exceed 32 characters. 

 

File 
Codec Compression 

includes encoder 

setting 

Parameters Frame rates Location 
Color 

Depth 
Audio Notes 

Export 

Settings 

Transcode 

Settings 

AVI Uncompressed None 

29.97 fps in North 

America 

25 fps in rest of 

world 

V-Max 4 or 

720P 
24 bpp 

PCM 

(uncompressed) 

Uncompressed files are 

larger but provide the best 

image quality. 

  

AVI 

WM9 

 Use: default “One-

pass quality VBR” 

 

29.97 fps in North 

America 

25 fps in rest of 

world 

V-Max 4 or 

720P 
24 bpp 

PCM 

(uncompressed) 

The Venus 7000 can only 

play compressed files that 

are less than 2 GB in size. 

  

SCS with DMP-8000 Video File Support 

 

Tech Note: 

 DMP-8000 using Advance Scripting:   Filenames for content files cannot exceed 32 characters. 

 DMP-8000 with CPP Control:  Filenames for content files cannot exceed 168 characters. 

 

File 

Codec 

Compression 

includes encoder 

setting 

Parameters Frame rates Location 
Color 

Depth 
Audio Notes 

Export 

Settings 

Transcode 

Settings 

AVI XVID  

29.97 fps US Video 

24 bpp 
PCM 

(uncompressed) 

Loss of Quality:  see 

Additional Notes that 

follow this table. 

  

30 fps LCD (VGA/DVI) 
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File 

Codec 

Compression 

includes encoder 

setting 

Parameters Frame rates Location 
Color 

Depth 
Audio Notes 

Export 

Settings 

Transcode 

Settings 

59.94 fps US Video 

60 fps LCD (VGA/DVI) 

25 fps Euro Video (PAL) 

50 fps Euro Video (PAL) 

AVI HUFF YUV 

Default: 

“Predict 

median” 

“Predict 

gradient” 

29.97 fps US Video 24 bpp 

or 32 

bpp for 

keying 

PCM 

(uncompressed) 
V-Net Pro only.   

30 fps LCD (VGA/DVI) 

AVI Uncompressed None 

59.94 fps US Video 
24 bpp 

or 32 

bpp for 

keying 

PCM 

(uncompressed) 

V-Net Pro only. 

Uncompressed files are 

larger but provide the best 

image quality. 

  

60 fps LCD (VGA/DVI) 

MKV 
Not directly supported by the DMP-8000 player.  Files with the .mkv format, must be taken into Content Studio.  Content Studio can then convert the .mkl file into 

another format that is supported by the DMP-8000 player. 

MOV H.264 None 

25 fps Euro Video (PAL) 

24 bpp 
PCM 

(uncompressed) 

MP4 is the preferred file 

format.  If MOV needs to be 

used it should be encoded 

with H.264 at a bit rate of < 

25 mbps. 

  

50 fps Euro Video (PAL) 

29.97 fps US Video 

30 fps LCD (VGA/DVI) 

59.94 fps US Video 

60 fps LCD (VGA/DVI) 



 

DD2175346 Page 9 

Oct 15, 2012 

File 

Codec 

Compression 

includes encoder 

setting 

Parameters Frame rates Location 
Color 

Depth 
Audio Notes 

Export 

Settings 

Transcode 

Settings 

MOV Quicktime None 

25 fps Euro Video (PAL) 

24 bpp 
PCM 

(uncompressed) 
None   

50 fps Euro Video (PAL) 

29.97 fps US Video 

30 fps LCD (VGA/DVI) 

59.94 fps US Video 

60 fps LCD (VGA/DVI) 

MPEG 

MPG 
 None 

25 fps Euro Video (PAL) 

24 bpp 
PCM 

(uncompressed) 
None   

50 fps Euro Video (PAL) 

29.97 fps US Video 

30 fps LCD (VGA/DVI) 

59.94 fps US Video 

60 fps LCD (VGA/DVI) 

MPEG-4 

MP4 

 

 None 

25 fps Euro Video (PAL) 

24 bpp 
PCM 

(uncompressed) 

Recommendation for DMP-

8000 Professional Edition:  

Render 1920x1080 content 

into an MP4 file container 

with H.264 encoding.  Use 

encoding settings*:   

 Main Profile,  Level 4.2 

 Set target encoding rate  

  

50 fps Euro Video (PAL) 

29.97 fps US Video 

30 fps LCD (VGA/DVI) 

59.94 fps US Video 
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File 

Codec 

Compression 

includes encoder 

setting 

Parameters Frame rates Location 
Color 

Depth 
Audio Notes 

Export 

Settings 

Transcode 

Settings 

60 fps LCD (VGA/DVI) 

to 20 Mbps (20,000 

kbps)  

 Set maximum rate to 25 

Mbps (25,000 kbps). 
*These were the settings available in 

Adobe After Effects and may not be 

offered on other creation tools.   

MP4V 
MP4V files are not supported by DMP-8000. Use  Content Studio to import a MP4V file into a presentation, or convert the file into a format 

supported by the applicable digital media player (Refer to Video File Conversion section for conversion directions.) 

WMV Utility available on Dakfiles for transcoding 

Additional Notes: Loss of Quality - Using XVid file compression can result in a dramatic loss of quality depending on the profile or CG 

solution being used.  If the Show Control System includes a DMP-8000 Professional Edition it is recommended to:  

 Use the file uncompressed (DMP-8000 Professional Edition is designed to handle uncompressed content). 

 Use HuffYUV codec for file compression. 

http://dakfiles.daktronics.com/downloads/Video_Products/Tools/VirtualDub/vdub_wmv_plugin.zip
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SCS with DMP-1500 Video File Support 

A Show control System with M3 Player supports the following recommended media file types. 

File 
Codec Compression 

includes encoder 

setting 

Parameters Frame rates Location 
Color 

Depth 
Audio Notes 

Export 

Settings 

Transcode 

Settings 

M3 Displays  

This display group is M3 controlled and managed through Venus 15000 software.  Galaxy Pro Displays (see below) are not included in this group. 

AVI 
Supports 

uncompress only 
 

Imports up to 300 

frames/message; 

Entire file size 

cannot exceed 1 

MB. 

   
Can only be imported into 

graphic frames. 
  

Galaxy Pro Displays  

This display group is also M3 controlled and managed through Venus 1500 software, but differs in its frame and capacity solutions from the M3 Displays group above. 

AVI 
Supports 

uncompress only 
 

Supports up to 

1200 message 

frames; file size of 

64MB (600 frames 

for Windows 

98/ME) 

   
Can only be imported into 

graphic frames 
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Text Input Support 

This section discusses procedures and recommendations regarding Show Control font support and 

foreign language support. 

Font File Support 

The Show Control System supports True Type fonts. Daktronics loads a pre-selected set on each system. 

While other True Type fonts may work well in a Show Control System, the ones listed below have been 

qualified with Show Control. 

 

Qualified True Type Fonts 

Arial Impact 

Arial Black Kartika 

Arial Black Italic Lucinda Console 

Arial Bold Lucinda Sans Unicode 

Arial Italic Microsoft Sans Serif 

Arial Narrow Palatine Linotype 

Arial Narrow Bold Modern 

Arial Narrow Bold Italic Monotype Corsiva 

Arial Narrow Italic Roman 

Book Antiqua Script 

Book Antiqua Sylfaen 

Book Antiqua Italic Σψμβολ (Symbol) 

Bookman Old Style Bold Tahoma 

Bookman Old Style Bold Tahoma Bold 

Bookman Old Style Bold Itali Times New Roman 

Bookman Old Style Italic Times New Roman Bold 

Century Gothic Times New Roman Bold Italic 

Century Gothic Bold Times New Roman Italic 

Century Gothic Bold Italic Trebuchet MS 

Century Gothic Italic Trebuchet MS Bold 

Comic Sans MS Trebuchet MS Bold Italic 

Comic Sans MS Bold Trebuchet MS Italic 

Courier New Verdana 

Courier New Bold Verdana Bold 

Courier New Bold Italic Verdana Bold Italic 

Courier New Italic Verdana Italic 

Franklin Gothic  (Webdings) 

Georgia  (Wingdings) 

Garamond  (Wingdings2) 

Garamond Bold (Wingdings3) 

Garamond Italic  
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Notes: 

 Note that a font’s point size follows print standards. For example, an 8-point 

selection is smaller than a 24-point selection, but 8 points does not equal 8 pixels. 

 True Type fonts are best used with higher resolution displays, such as matrix sizes 

greater than 40 pixels high. 

 
In addition to True Type fonts, DMP-1500 systems support Venus fonts. 

Install Additional Fonts 

To add additional fonts, use the font installation procedures recommended by the Microsoft Corporation 

for the version of the Windows operating system that your Show Control System equipment is running. 

The font must be loaded on both the Display Studio / Content Studio user station(s) and the Digital Media 

Player machine. 

 

Note: Please ensure that you have any required permissions and all necessary licenses to 

use any fonts that you will be adding to a Show Control System. 

 

For Windows XP systems, refer to http://tinyurl.com/InstallFontXP. 

For Windows Vista systems, refer to http://windows.microsoft.com/en-US/windows-vista/Install-or-

uninstall-fonts. 

For Windows 7 systems, refer to http://windows.microsoft.com/en-US/windows7/Install-or-delete-fonts. 

 

 

Notes:  

 Fonts with a license which restricts their embeddability cannot be used with 

Content Studio. 

 OpenType fonts are not supported for use in a Show Control System. 

Install Foreign Language Support 

Complete the below steps to add support for foreign languages to your Show Control System equipment. 

 

 

Note: You may need to use the Windows
®

 7, Vista, or XP installation disc while specifying 

initial settings. 

http://tinyurl.com/InstallFontXP
http://windows.microsoft.com/en-US/windows-vista/Install-or-uninstall-fonts
http://windows.microsoft.com/en-US/windows-vista/Install-or-uninstall-fonts
http://windows.microsoft.com/en-US/windows7/Install-or-delete-fonts
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Windows 7 and Windows Vista machines: 

1. Click the Start button. 

2. Click Control Panel. 

3. From the Control Panel, navigate to Regional and Language Options. 

To set how programs format numbers, currencies, dates, and times: 

4. Click the Formats tab. 

5. Select the desired format from the available list and click Apply. 

To configure your desired input language(s): 

6. Click the Keyboards and Languages tab. 

7. Click Change keyboards... to open the Text Services and Input Languages dialog box. 

8. The Installed Services list indicates the languages that are currently supported for inputting 

information into the computer. To add additional languages, click Add... to open the Add Input 

language dialog box. 

9. Place a checkmark in all checkboxes applicable to the languages you wish to add. 

10. Click OK. Click Apply. 

11. Click OK. 

To configure non-Unicode support for added languages: 

12. Click the Administrative tab. 

13. In the Language for non-Unicode programs group, click the Change system locale... button. 

14. Select the desired locale from the drop-down list. Click OK. 

15. Restart your computer to apply changes. 

An icon appears in the desktop taskbar (usually located at the bottom right of the screen). The icon 

indicates the current input locale as an abbreviation. 

Windows XP machines: 

1. Click the Start button. 

2. Click Control Panel. 

3. From the Control Panel, navigate to Regional and Language Options. 

To set how programs format numbers, currencies, dates, and times: 

4. Click the Regional Options tab. 

5. In the Standards and Formats group, select the desired format from the available list and click 

Apply. 
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To configure your desired input language(s): 

6. Click the Languages tab. 

7. Click Details... to open the Text Services and Input Languages dialog box. 

8. The Installed Services list indicates the languages that are currently supported for inputting 

information into the computer. To add additional languages, click Add... to open the Add Input 

language dialog box. 

9. Select the desired Input language from the drop-down list. 

10. Select the desired configuration and click OK. Click Apply. 

To configure supplemental language support (languages not typically installed with Windows): 

11. To Install files for complex script and right-to-left languages (including Thai), place a 

checkmark in the appropriate checkbox. Click Apply. 

12. To Install files for East Asian languages, place a checkmark in the appropriate checkbox. Click 

Apply. 

To configure non-Unicode support for added languages: 

13. Click the Advanced tab. 

14. Select the desired language from the drop-down list in the Language for non-Unicode 

programs group. Click Apply. Restart your computer to apply changes. 

An icon appears in the desktop taskbar (usually located at the bottom right of the screen). The icon 

indicates the current input locale as an abbreviation. 

Switch a machine’s input language 

Complete the below steps to switch the input language of the machine you’re working on, such as if you 

wish to use foreign language text to create a Content Studio presentation. 

1. In the Windows taskbar, click the Language icon EN. 

2. Select the desired language from the pop-up list.  

 

Note: If creating a Content Studio presentation, before saving the presentation, make sure 

to switch the input language back to English. 

Converting a group of media files at once 

In instances where you have a group of media files that you would like to play on your display but which 

are not natively compatible with your digital media player, Content Studio’s batch converter can help you 

save a great deal of time and effort in the preparation of these files for playback. This tool allows you to 

quickly and easily convert a group of media files into one or more Content Studio presentations so that 
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they will be supported by your Show Control System. 

Note: This section will step you through creating and processing a batch conversion session for the first 

time. Subsequent uses of the batch converter will begin with step 5. 

1. From within Content Studio, click the Content Studio Button and select Batch Conversion to open 

the New Presentation Wizard. 

 

 
 

2. Select whether you wish to complete a batch conversion for a particular Display or for a Display 

Type. 

To help you with the decision, consider the following: 

 If you want to convert content that you intend to only play on one specific display, select Display. 

 If you have multiple displays that use the same type of digital media player and have the same 

dimensions, and you want to convert content that will be able to be played on any of those 

displays, select Display Type. 

 

 
 

3. Next, select the display or display type that you wish to create a presentation for. Click the desired 

display or display type, and click Finish to continue. 

4. In the Save As dialog box, choose where you would like to save your batch conversion session file, 

provide it with a filename, and click Save to be taken to the Batch Conversion window. 
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Note: The batch conversion session file is simply the settings that you configure for the batch 

conversion session – it does not contain your media file(s) or Content Studio presentation(s). 

5. When taken to the Batch Conversion window, you will be presented with the Main options, where you 

will be able to specify which file(s) you wish to convert, and where you would like the Content Studio 

presentation(s) containing the file(s) to be saved. 

 

 

Notes: 

 If you wish to open an existing batch conversion session, click Open Session, 

and select the session in the Open window. 

 If you wish to create a new batch conversion session, click New Session, and 

start with Step 2. 

 

 
 

a. In the Source folder portion of the window, click Browse to open the Browse For Folder 

window. Select the folder which contains the file(s) you wish to convert, and click OK. Any files in 

that folder which are capable of being converted will appear in the Media files to convert box. 

b. In the Media files to convert box, place checkmarks next to each file you wish to convert. 

c. By default, Content Studio will convert each of your files into its own separate Content Studio 

presentation (meaning that if you convert 10 files, you will end up with 10 separate Content 

Studio presentations). If you would prefer to have all of the files combined into a single 

presentation (meaning that if you convert 10 files, you will end up with a single Content Studio 

presentation with 10 layouts), place a checkmark next to Combine media files into a single 

presentation, and specify a filename for the presentation in the Presentation Name field. 

d. In the Target folder field, the default content folder for your selected display/display type’s 

digital media player will be pre-populated. To choose a different destination folder for the 

presentation(s), click Browse to open the Browse For Folder window. Select the folder which 
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contains the file(s) you wish to convert, and click OK. 

e. To configure additional options for how your presentation’s layout(s) are going to be created 

and/or for how file(s) are to be imported into the presentation(s), proceed to Steps 6 and/or 7. 

Otherwise, proceed to Step 8. 

6. To configure additional options for how your presentation’s layout(s) are going to be created, click 

the Layout Options tab. 

 

 
 

a. Specify how long you wish for your layout(s) to last in the Duration field. Enter the desired length 

of time in the textbox and select the appropriate unit of time using the provided drop-down list. 

b. If you wish to add a transition effect to the beginning of the layout(s), use the Entry Transition 

drop-down list to select the desired transition. 

c. If you wish to add a background color to your layout(s), click Change to open the Background 

Fill window. Select the desired background color and click OK to continue. 

d. To configure additional options for how file(s) are to be imported into the presentation(s), 

proceed to Step 7. Otherwise, proceed to Step 8. 

7. To configure additional options for how your file(s) are to be imported into the presentation(s), click 

the Media Options tab. 

 

 
 

a. To specify how you wish for the media file to be fit on your layout, select the desired option from 

the Fit Mode drop-down list. Select from the following options: 

Best-Fit: The content will be resized to fit the layout while maintaining the content’s aspect ratio. 

To the extent the content does not fill the whole layout, transparent areas will be added to the 
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layout (which would allow the layout’s background fill or other elements behind the content to be 

visible). 

Stretch: The content will be resized to take up the entire layout, without maintaining its aspect 

ratio. Content imported in this mode may become distorted. 

Normal: The content will be imported exactly as-is with no resizing. 

 

 

Note: The content’s Fit Mode can be changed after conversion takes place by 

opening the presentation and editing it in Content Studio. 

 

b. To specify a video compression codec that should be used to import video, use the Video 

Compression drop-down list. 

 

 

Tip: If the resulting file size of your presentations is a concern, choose a video 

compression option other than Full Frames (Uncompressed). 

 

8. At any time, to save the settings that you have configured with a different filename, click Save 

Session As to open the Save As window. Choose the location where you wish to save the session and 

provide it with a file name, and click Save. 

9. When ready to initiate the conversion process, click Convert. You will be taken to the Confirmation 

screen to view the conversion progress and results. 

 

 

Adding content to digital media player 

Follow the steps in this section to properly copy content to your digital media player so that it can be 
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played on a display. 

DMP-7000 & DMP-8000 

1. Plug the portable storage device into one of the user station’s USB ports, or insert the CD, DVD or 

memory card into the appropriate drive. 

2. In Windows, open Windows Explorer (accessible via the Start Menu or by pressing the [Windows key 

+ E]). 

3.  In Windows Explorer, navigate to the portable storage device, and then the folder containing the 

media files. 

4. Within the folder, select the media files to be transferred by clicking them with the mouse. Multiple 

files may be selected by pressing and holding [CTRL] while clicking. 

5. After selecting the file(s), copy them to the Windows clipboard. (Copying may be done in Windows 

Explorer by choosing the Edit menu, and then by clicking on Copy; or by pressing [CTRL+C].) 

6. Locate the appropriate content folder for your Digital Media Player. 

DMP-7000 

In Windows Explorer, navigate to the DMP-7000 folder designated for the desired display, which is 

generally C:\V7000\Sign Folder\Content Folder\; where Sign Folder refers to the folder which is 

designated for the desired display (Ex: 448x800 RGB16MB L Sign) and Content Folder refers to the 

folder where the media files are to be stored (Ex: Crowd Prompts). 

 

 

Notes: 

 A DMP-7000 Content Folder’s name must end in .Lib for it to be 

recognized as a content library. 

 DMP-7000 may have its designated sign folder on the D drive. 

DMP-8000 

In Windows Explorer, navigate to the DMP-8000 content folder designated for the desired display, 

which is generally located at the following location: 

For Windows XP machines: C:\Documents and Settings\All Users\Application 

Data\Daktronics\VNET4\Content\Content Folder; where Content Folder refers to the folder where 

you wish to store the particular media file(s) you are importing. 

For Windows 7 machines: C:\ProgramData\Daktronics\VNET4\Content\Content Folder, where 

Content Folder refers to the folder where you wish to store the particular media file(s) you are 

importing. 

7. Paste the files copied in Step 5 into the chosen folder. (Pasting may be done in Windows Explorer by 

choosing the Edit menu and then clicking on Paste, or by clicking [CTRL+V].) 

8. Repeat steps 3-7 as necessary until all media files have been transferred. 
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DMP-1500 

1. Ensure that the storage device containing the content is connected to your user station. 

2. Using Windows Explorer, navigate to the storage device containing the content. 

3. Select the content file(s) you wish to play on your DMP-1500 display by clicking them with your 

mouse. Multiple files may be selected by pressing and holding [Ctrl] while clicking. 

4. Copy the selected files to the Windows Clipboard by opening the Edit menu and selecting Copy (or 

by pressing [Ctrl+C]). 

5. Using Windows Explorer, navigate to a folder on your user station which is easily accessible, or where 

you wish to store the files. 

6. Using Content Studio, import the files into a presentation. 

7. Save the Content Studio presentation to your DMP-1500’s database. 

8. In Display Studio, use the M3 File Manager to copy your presentation(s) to your digital media player. 

Video File Conversion / Encoding Guidelines  

In order to convert/encode the video files, the following open source computer software is recommended 

and available for download on the Internet at no charge.   

The type of computer system be used for conversion/endocing process (e.g. one running Microsoft 

Windows or Mac OS) will determine the software required.  The desired conversion/encoding video 

resulting will depend on the control system or player that will be using it.  

Show Control System - A Show Control System includes Display Studio, Content Studio and is associated 

with multiple types of digital media players (DMP-7000, DMP-8000, M3, etc).  A Show Control System 

operates on a Microsoft Windows OS and requires converted/encoded video to be compatible with its OS, 

player and other components.  While the  video could be converted/encoded on a Mac OS computer, the 

result would have to meet the requirements of the player and other compoents in the SCS.  

Visiconn - A system using Visiconn, such as a digital display network (bill boards) is operatored through 

the web.  Such as system works with players and other components that operator on specific computer 

operating systems (usually Microsoft Windows OS). Video that will be uploaded into and scheduled 

through a Visiconn System, will need to be converted/encoded  to meet the requirements the players and 

other components in the system.  The conversion can take place on a computer with an OS that differs 

from the Visicon System’s players and components, as long as the resulting video meets the requirements 

of the Visicon System’s players and components.   

To help operators have a successful Show Control System and/or Visiconn experience, this section 

provides Daktronics’ recommendations for converting video files into a format supported by these 

systems.  

To request support for a new file type, contact Display Studio Support at 1-800-DAKTRONICS (1-800-325-

8766) (U.S. & Canada) or +1-605-697-4000 (Outside U.S. & Canada). 
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Note:  Video files can be converted in a wide variety of ways. This section simply contains 

Daktronics’ recommendations for the most cost-effective methods for converting some of 

the most common video file formats into a format that your Show Control System can 

handle. To the extent that use of third-party software applications is recommended, users 

are encouraged to consult the help resources of those applications for further assistance. 

Follow the proper flow for your digital media player: 

For DMP-7000 Content: 

1. Install Apple Quicktime 

2. Install VirtualDub 

3. Install Video File Converter 

Utility 

4. Configure VirtualDub 

5. Configure Video File 

Converter Utility 

6. Using the Video File 

Converter Utility 

 

For DMP-8000 Content: 

1. Install Apple Quicktime 

2. Install VirtualDub (Windows-based 

Systems), or 

Install ffmpegX (Mac OS-based 

Systems) 

3. DMP-8000 Settings (XviD), or 

DMP-8000-PE Settings (HuffYUV) 

4. Using VirtualDub to Convert Files 

(Windows-based Systems), or 

Using ffmpegX to Convert Files (Mac 

OS-based Systems) 

For DMP-1500 Content: 

1. Install Apple Quicktime 

2. Install VirtualDub 

3. Configure VirtualDub 

4. Using VirtualDub to 

Convert Files 

 

Install Apple Quicktime 

If you intend to convert MOV files, Apple Quicktime must be installed before file conversion may take 

place. This third-party application can be downloaded at no cost by visiting 

http://www.apple.com/quicktime/download/. 

Install VirtualDub (Windows-based Systems) 

Daktronics recommends using VirtualDub for converting video files to a supported file type in a Windows 

environment. VirtualDub is a third-party software application, and therefore must be downloaded from 

the Internet. Complete the steps in the following sections to install VirtualDub. 

Installation 

1. Navigate to VideoHelp.com’s VirtualDub page at http://www.videohelp.com/tools/VirtualDub. 

2. On the top row of the table, click the link for Download (direct link). 

 

http://www.apple.com/quicktime/download/
http://www.videohelp.com/tools/VirtualDub
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3. When the File Download window opens, click Open. 

4. When the Windows Explorer window opens with the contents of the ZIP file, click Extract all files. The 

Extraction Wizard will appear. 

5. Follow the on-screen instructions provided by the wizard to extract the files. It is recommended that 

you extract the files to a location able to be easily located, such as C:\Tools\VirtualDub. Note that this 

will be the permanent location for your VirtualDub files. 

6. In this VirtualDub folder, create two subfolders named Plugins32 and Plugins64. This will help you in 

the next part of the process. 

Plug-in Setup 

To allow VirtualDub to work with the necessary video file formats, the appropriate plug-ins for these 

formats must be downloaded and loaded into VirtualDub. Complete the following steps. 

1. Return to VideoHelp.com’s VirtualDub page at http://www.videohelp.com/tools/VirtualDub. 

2. Scroll down to Import plugins. 

 

 
 

3. Download the plug-ins by clicking the appropriate link and saving the corresponding ZIP files to a 

location able to be easily located, such as your Desktop: 

a. MPEG2 import plug-in (MPEG2.zip) 

b. WMV import plug-in (WMV.zip) 

c. MOV import plug-in (Quicktime_VD_v.0.2.0.0_bin.zip) 

4. Extract the ZIP files to a convenient location. Note that this will only be a temporary storage location 

for these files. 

5. Load the plug-ins into VirtualDub by completing the following steps. 

MPEG2 Plug-ins 

http://www.videohelp.com/tools/VirtualDub
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a. Open the folder containing the files extracted from MPEG2.zip. The contents of this folder should 

resemble the following: 

 

 
 

b. Move MPEG2.vdplugin to the Plugins32 subfolder of your VirtualDub folder. 

c. Move MPEG264.vdplugin to the Plugins64 subfolder of your VirtualDub folder. 

WMV Plug-ins 

a. Open the folder containing the files extracted from WMV.zip. The contents of this folder should 

resemble the following: 

 

 
 

b. Move WMV.vdplugin to the Plugins32 subfolder of your VirtualDub folder. 

c. Move WMV64.vdplugin to the Plugins64 subfolder of your VirtualDub folder. 

MOV Plug-in 

a. Open the folder containing the files extracted from Quicktime_VD_v.0.2.0.0_bin.zip. The contents 

of this folder should resemble the following: 

 

 

 

b. Move Quicktime.ini to your VirtualDub folder. 
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c. Move Quicktime.vdplugin to the Plugins32 subfolder of your VirtualDub folder. 

Note: The MOV plug-in does not have a 64-bit version. 

6. Once all files have been moved, all of the other files extracted from the ZIP files may be discarded.  

Install ffmpegX (Mac OS-based Systems) 

If using a Mac OS-based system, ffmpegX is the recommended utility for converting video files for your 

DMP-8000 to XviD AVI format. ffmpegX provides a GUI interface to three open source UNIX video 

encoding products. ffmpegX is free to use, however the author asks for a $15 donation.  

1. With your internet browser, navigate to http://www.ffmpegx.com/download.html to reach the 

ffmpegX download site. 

 

 
 

2. Click the Download link for the most recent version of ffmpegX.  

3. While you’re on the download page, scroll down until you see the following text:  

 

 
 

Note: You will need to download the mpeg2enc, mplayer, and mencoder binaries.  

 

http://www.ffmpegx.com/download.html
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4. While holding down the Control key, click the first link and select Save Linked File As. For ease of 

use, save the files to your desktop. You may simply click the second link and you will be directed to 

the download page.  

 

 
 

5. Once the program has downloaded, install ffmpegX by dragging the icon from your download 

location to your Applications folder.  

6. Double-click to run the application for the first time. Depending on the version of Mac OS you’re 

running, you may be prompted with a warning. Select Open.  

 

 
 

7. It’s very likely that you will not have all of the UNIX binaries installed. If this is the case, you will be 

prompted with the screen below. Click the checkbox next to each associated plug-in and select 

Locate. For each plug-in browse to the file you saved in Step 4 of this tutorial. Once you’ve selected 

all three downloads, authenticate the installer by typing your password and selecting Install.  

 

 



 

DD2175346 Page 27 

Oct 15, 2012 

 

8. You should now see the following screen:  

 

 

 

Install Video File Converter Utility (Windows-based Systems) 

The Video File Converter Utility is an application which is designed to automatically convert video from 

any of a variety of file types into the AVI file format so that it can be played on a DMP-7000 display. This 

process is done completely “behind the scenes” and requires no user interaction – simply tell the utility 

what folder it should be monitoring, and anytime a new video file is placed in that folder, it will 

automatically perform the conversion so that those videos will be ready for use as quickly as possible. 

The utility is intended to have as minimal of a “footprint” as possible in a user’s content management 

routine. When the new AVI file is created, it will have the same filename and will be stored in the same 

folder as the original file. Users can even configure whether or not they want the utility to retain or delete 

the original video file following its conversion. 

1. Navigate to http://dakfiles.daktronics.com/downloads/Video_Products/VideoFileConverter/. 

2. Click VideoFileConverterSetupV20.zip. 

3. After the File Download window opens, select to Save the file to a location that will be easy to locate. 

4. Extract the contents of the zip file to a convenient location. There will be one file: 

VideoFileConverterSetup.exe. 

5. After it has been extracted, double-click VideoFileConverter.exe to initiate the installation process. 

6. If you encounter any security warning windows, click Run to proceed. 

7. In the Welcome screen of the Wizard, click Next to continue. 

 

 

http://dakfiles.daktronics.com/downloads/Video_Products/VideoFileConverter/
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8. In the Select Installation Folder screen, installation preferences may be modified, if necessary. 

a. If it is necessary to install the utility to a folder other than the default location, enter a new folder 

path in the Folder: text box, or click Browse… to choose the new location. 

b. To view more information about your system’s hard drives and the storage space available on 

each, click Disk Cost… 

c. To specify whether the utility should be made available to all of your computer’s user accounts 

(Everyone), or just the account that you are currently logged into (Just Me), select the 

corresponding radio button. 

 

 
 

9. Click Next to proceed. 
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10. In the Confirm Installation screen, click Next to start the installation. 

11. In the Installation Complete screen, click Close to exit the installer. 

 

 

Tech Notes:  It is recommended that Windows Update be used to check for any critical 

updates to the .NET Framework.  

Configure VirtualDub (Windows-based Systems) 

After any necessary applications have been installed on the conversion computer, VirtualDub should be 

configured to the appropriate settings for the type of video file you wish to convert your video files to. 

Follow the steps which correspond to the digital media player you are managing video files for. 

DMP-7000 Settings 

1. Open VirtualDub by navigating to your VirtualDub folder and double-clicking VirtualDub.exe. 

2. Navigate to Video menu > Compression… (or press [CTRL+P]) to open the Select video 

compression window. 

3. In the scrollable list of video codecs, select the appropriate codec for the digital media player you will 

be playing the video files on. 

 

 
 

It is recommended to use either Uncompressed RGB/YCbCr (provides best quality but requires 

largest file size) or Microsoft Windows Media Video 9 (good choice to reduce file size). 

 

 

Note:  If the desired codec does not appear on the list, it will need to be installed. 

Refer to Installing Additional Codecs for more information. 

 

4. After selecting the appropriate codec, click OK. 

5. Set the audio processing mode by navigating to the Audio menu and ensuring that Direct stream 
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copy is selected. 

 

 
 

6. Save your configuration settings by navigating to the File menu > Save processing settings… (or by 

pressing [CTRL+S]). 

7. Save the settings into your VirtualDub folder with a descriptive filename. Configuration is now 

complete. 

DMP-8000 Settings (XviD) 

1. Open VirtualDub by navigating to your VirtualDub folder and double-clicking VirtualDub.exe. 

2. Navigate to the Video menu and select Full Processing Mode. 

3. Navigate to the Video menu and select Compression… (or press [CTRL+P]). 

4. Select the Xvid MPEG-4 Codec and click the Configure Button.  

 

 
 

5. In the Xvid Configuration menu, set the Profile @ Level to Xvid HD 720.  
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6. Click the  button to the right of Profile @ Level. In that menu, under the Profile tab:  

 

 
 

a. Set the Quantization type to “MPEG”. 

b. Set the Adaptive Quantization to “Variance-Masking”. 

c. Disable the Interlaced Encoding check box (default is unchecked). 

d. The Global Motion Compensation is unavailable and grayed out. 

e. Enable B-VOPs 
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i. Set Max consecutive BVOPs to 2 

ii. Set Quantizer ratio to 1.5 

iii. Set Quantizer offset to 1.00  

7. Click OK to return to the Xvid Configuration main settings page. 

8. Locate the Target Bitrate button.  If it is not visible, click on the Target Quartizer: button to change 

to the Target Bitrate button. (The Target Bitrate button toggles between “Target bitrate (kbps)” and 

“Target quantizer”). 

9. Verify that the Target bitrate slider is positioned all the way to the right at “9708 kbps”. 

10. Set the Quality Preset to “(User defined)”. 

11. Next to the Quality preset:, click the  button. 

12. Under the Motion tab:  

 

 
 

a. Set Motion Search Precision to “6 – Ultra High” 

b. Set VHQ mode to “4 - Wide Search” 

c. Set VHQ metric to “0 – PSNR” 

d. Check the Use VHQ for bframes too box 

e. Check the Use chroma motion box 

f. Uncheck the Turbo ;-) box 

g. Verify the Frame Drop ratio is “0” 

h. Verify the Maximum I-frame interval is “300”  

13. Under the Quantization Tab:  
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a. Verify the Min I-Frame quantizer is “1” 

b. Verify the Max I-frame quantizer is “10” 

c. Verify the Min P-Frame quantizer is “1” 

d. Verify the Max P-frame quantizer is “31” 

e. Verify the Min B-frame quantizer is “1” 

f. Verify the Max B-frame quantizer is “31” 

g. Verify the Trellis quantization box is checked  

14. Click OK to return to the Xvid Configuration main settings page. 

15. Click OK to return to the Select video compression page. 

16. Click OK to return to the VirtualDub home screen. 

17. Save your configuration settings by navigating to the File menu > Save processing settings… (or by 

pressing [CTRL+S]). 

18. Save the settings into your VirtualDub folder with a descriptive filename. Configuration is now 

complete. 

DMP-8000-PE Settings (HuffYUV) 

1. Open VirtualDub by navigating to your VirtualDub folder and double-clicking VirtualDub.exe. 

2. Navigate to Video menu > Compression… (or press [CTRL+P]) to open the Select video 

compression window. 

3. In the scrollable list of video codecs, select Huffyuv vX.X.X from the list and click the Configure 

button. 
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Note:  The HuffYUV codec is able to achieve a near lossless conversion, however its 

resulting file size can be quite large. This codec is only recommended for use with 

DMP-8000-PE systems. 

 

4. From the Huffyuv configuration dialog box, in the YUY2 compression method drop-down list, 

select Predict median (best). 

Note: This setting is recommended, and you should not experience any problems when using it. If 

you find you are dropping frames, however, try switching to a lower compression level. 

5. In the RGB compression method drop-down list, select <-- Convert to YUY2. 

6. Place a checkmark in the Always suggest RGB format for output checkbox. 

7. Click OK. 

8. Save your configuration settings by navigating to the File menu > Save processing settings… (or by 

pressing [CTRL+S]). 

9. Save the settings into your VirtualDub folder with a descriptive filename. Configuration is now 

complete. 

DMP-1500 Settings 

1. Open VirtualDub by navigating to your VirtualDub folder and double-clicking VirtualDub.exe. 

2. Navigate to Video menu > Compression… (or press [CTRL+P]) to open the Select video 

compression window. 

3. In the scrollable list of video codecs, select Uncompressed RGB/YPbCr. 
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Note:  Remember that M3 displays only support file sizes which do not exceed 1 MB 

and GalaxyPro® displays only support files which do not exceed 64 MB. 

 

4. Click OK. 

5. Save your configuration settings by navigating to the File menu > Save processing settings… (or by 

pressing [CTRL+S]). 

6. Save the settings into your VirtualDub folder with a descriptive filename. Configuration is now 

complete. 

Test conversion process 

It is recommended to now test the conversion process to confirm its proper operation. This is completed 

by manually converting a file by using VirtualDub. 

1. If not already opened, launch VirtualDub. 

2. Navigate to File menu > Open video file… to be taken to the Open video file dialog box. 

3. Navigate to a video file you wish to use to test VirtualDub, and click Open. 

4. Navigate to File menu > Save as AVI… to be taken to the Save AVI File dialog box. 

5. Navigate to the location where you wish to save the AVI version of the selected video file, and click 

Save. 

6. After the saving process is complete, use Windows Explorer to locate the AVI file. Using whatever 

method you prefer, play the file to confirm that it was converted properly. 

Configure Video File Converter Utility 

The next step in the setup procedure for DMP-7000 content is to configure the video file converter utility 

by entering the locations of the files you have set up in the previous sections of this process. 

1. Launch the Video File Converter by navigating to Start menu > All Programs > Daktronics > 
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Utilities > Video File Converter. 

2. Click  to open the Edit Configuration window. 

 

 
 

3. Enter the applicable information for your desired system setup. File paths may be indicated by typing 

them in the corresponding text boxes, or by clicking the corresponding Browse button to locate the 

appropriate file locations. The needed information is as follows: 

a. Path to VirtualDub: Indicate the location of the VirtualDub.exe file in your VirtualDub folder. 

b. Path to VCF: Indicate the location of the VirtualDub configuration file (.vcf) you created for your 

DMP-7000 configuration. 

c. Path to monitor: Indicate the folder that you wish for the Video File Converter to monitor.  This is 

the folder (as well as its subfolders) that the utility will continually check for video files to convert. 

d. Delete Original File: Select whether the utility should, after converting a file, delete the original 

video file. If the box is checked, the utility will delete the original file after it is converted. If the 

box is unchecked, both the converted file and original file will be retained. 

e. File Filter List: Contains the list of file types that the utility will watch for and, if found, will 

attempt to convert to AVI format. Use the Add button to enter a new file extension (*.xxx) to 

watch for; the Remove button to remove a selected extension from the list; or the Edit button to 

modify a selected extension on the list. 

4. When finished making changes, click OK to save them. 

Using the Video File Converter Utility 

 

Note: Due to high resource demand of the file conversion process, it is recommended that the 

process not be initiated while any video file playback operations are taking place.  

 

The file converter utility is designed to: (a) automatically launch when the computer on which it is installed 

is booted up, (b) continuously monitor the specified folder for new video files, and (c) automatically 

convert new files to AVI format, according to the configured settings. If this is the desired setup for your 
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system, there is nothing else you need to do. 

If, on the other hand, it is desired to not have the utility automatically running in the background, and 

instead only have it run after it is manually opened, complete the following steps to remove the utility 

from the Windows startup process. 

1. Navigate to Start menu > All Programs and locate the Startup folder. 

2. Right-click on Startup and select the Open option that applies to your Video File Converter utility 

installation: 

 If, during the utility installation, you selected for the utility to be available for Just Me, select 

Open. 

 If, during the utility installation, you selected for the utility to be available for Everyone, select 

Open All Users. 

3. Locate Video File Converter and delete it by right-clicking it and selecting Delete. After deleting it, it 

will no longer be automatically launched by the Windows startup process. 

 

 

Using VirtualDub to Convert Files (Windows-based Systems) 

When you are ready to convert your video files for your DMP-8000 or DMP-1500, Daktronics recommends 

using VirtualDub to complete this process. Before beginning, ensure that VirtualDub and any necessary 

codecs and plug-ins have been installed, and that you have created a VirtualDub configuration file with 

the appropriate settings for your digital media player’s content. 

1. If not already opened, launch VirtualDub. 

2. Navigate to File menu > Load processing settings… to be taken to the Load configuration script 

dialog box. 

3. Select the .vcf file which contains the appropriate settings for your digital media player’s content, and 

click Open. 

4. Navigate to File menu > Open video file… to be taken to the Open video file dialog box. 

5. Select the video file you wish to convert, and click Open. 

6. Navigate to File menu > Save as AVI… to be taken to the Save AVI File dialog box. 

7. Navigate to the location where you wish to save the AVI version of the selected video file, and click 
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Save. 

Using ffmpegX to Convert Files (Mac OS-based Systems) 

If using a Mac OS-based system to convert your DMP-8000 media files, Daktronics recommends using 

ffmpegX to complete this process. 

1. Launch ffmpegX. 

2. From the ffmpegX main screen, click Open to select your uncompressed file.  

3. Select Save As, and specify a location where you would like to save your compressed video.  

4. If the filename for the compressed video does not have the .avi file extension, add it to the end of the 

filename. 

5. Make sure to specify the target format as AVI XviD.  

 

 
 

6. From the Video tab, ensure that XviD [.AVI] (mencoder] is selected as the video codec. Make sure 

the Video Bitrate is set to at least 9000 kbit/s. It is essential that the Video Size matches the size of 

your display.  

 

 
 

7. From the Audio tab, uncheck Encode Audio.  
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8. From the Options tab, check the checkbox next to High Quality, Use B-frame, and Trellis 

Quantization.  

 

 
 

9. Select the Encode button. 

Installing Additional Codecs 

Codec (a portmanteau of coder-decoder) refers to computer software which is capable of taking an analog 

audio or video signal and (a) coding the signal into a digital form for transmission purposes, and then (b) 

after it is transmitted, decoding the digital signal into a form closely resembling the original analog signal. 

Locating Daktronics-approved Codecs 

After determining that you need a particular codec, first verify that it is not already directly supported by 

your digital media player. If the codec does not already appear on your digital media player’s supported 

file list, it is necessary to download and install it. 

The following codecs have been qualified for use with Daktronics products: 

 WM9 - wmv9VCMsetup.exe 

The WM9 Codec is required to perform WM9 compression on AVI files. 

http://dakfiles.daktronics.com/downloads/venus7000/CODECs/wmv9VCMsetup.exe
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Use Scenario:  When converting MOV files, which are smaller files, to AVI file format, the resulting AVI 

file will be large.  If system storage is limited the AVI file can be compressed within VirtualDub if the 

WM9 codec is available. 

 XviD - Xvid-1.2.2-07062009.exe 

XVID is an open source codec that is freely available for most computing platforms and works with 

both VirtualDub and ffmegX conversion tools. 

Use Scenario:  In both Windows-based and MAC OS-based video encoding scenarios, XVID must be 

obtained and installed. 

 Huffyuv -  huffyuv-2.1.1.zip 

Huffyuv is a very fast, lossless Win32 video codec. "Lossless" means that the output from the 

decompressor is bit-for-bit identical with the original input to the compressor. "Fast" means a 

compression throughput of up to 38 megabytes per second (on a 416 MHz Celeron processor).  

Use Scenario:  Huffyuv also supports lossless compression of RGB data, making it useful for the 

output of programs like VirtualDub. 

Note:  Before attempting to install HuffYUV on a DMP-8000 machine, you must disable File Based Write 

Filtering. 

 ffmpegX - x264vfw  Download x264vfw software for free  

ffmpegX provides a GUI interface to three open source UNIX video encoding products. ffmpegX is 

free to use, however the author asks for a $15 donation.  

Use Scenario:  If using a Mac OS-based system, in addition to XVID, ffmpegX must be obtained and 

installed.  

To locate a codec, click on the corresponding link above, or navigate to 

http://dakfiles.daktronics.com/downloads/venus7000/CODECs/ and locate the codec on the list of files. 

Installing a Codec 

In many cases, installing a codec is as simple as downloading the file and running the installation program 

by double-clicking on the file. In some cases, however, it involves a different procedure. A safe “rule of 

thumb” that may be used is the following: 

1. Click the link to the file and download it to an easily accessible location. 

2. If the codec consists of one file, such as wmv9VCMsetup.exe, simply double-click the file to begin 

the installation process. Follow the on-screen directions to complete the installation. 

 

 
3. If the codec consists of multiple files, such as huffyuv-2.1.1.zip (which is a ZIP file containing 

multiple files), one of those files is likely a README or READ FIRST file, containing instructions on 

how to complete the installation of the codec. Follow those directions to successfully complete the 

http://dakfiles.daktronics.com/downloads/venus7000/CODECs/Xvid-1.2.2-07062009.exe
http://dakfiles.daktronics.com/downloads/venus7000/CODECs/huffyuv-2.1.1.zip
http://dakfiles.daktronics.com/downloads/venus7000/CODECs/x264vfw%20%20Download%20x264vfw%20software%20for%20free%20at%20SourceForge.net.url
http://dakfiles.daktronics.com/downloads/venus7000/CODECs/
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installation. 

 

 

Disable File Based Write Filtering (FBWF) 

Before installing the HuffYUV codec on a DMP-8000 machine, it is necessary to disable File Based Write 

Filtering (FBFW), which is a feature included on Windows XP Embedded systems. 

To disable FBWF, navigate to the Start menu and click FBWF Control. The FBWF Control warning window 

will appear, indicating that FBWF will be disabled and that the system will reboot. Press any key to reboot 

the machine. 

 

   
 

 

Tech Note:  To enable FBWF, use the same steps as above. The FBWF “Warning” 

window will instead announce that File-Based Write Filter is Going to be Enabled, 

which will also require rebooting the machine. 

 


